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Welcome to OpenXDF

The Consortium would like to thank everyone that has participated in the OpenXDF forums and everyone who has
given us direct feedback over the past couple of years. Your constructive criticism and insights have contributed
greatly to the development of OpenXDF, XDFviewer, and maXimus.

Changes in Version 1.0

Packaging, Compression, and Encryption

Previous versions of the specification allowed for proprietary compression and encryption with the understanding that
such methods would render the file unusable by other systems.

It became obvious that using OpenXDF to exchange data between research and clinical institutions would require
standardized and secure methods of encrypting sensitive information for transport. This version of the specification
introduces the ability to secure OpenXDF files using strong, password-based TwoFish encryption.

Experience with OpenXDF in the field highlighted the utility of being able to store sections of an OpenXDF header
separately. This version of the specification introduces packaging sections that provide details on how to use ZIP with

DEFLATE to package and compress multiple OpenXDF headers, and other types of files, into a single file that all
compatible systems will be able to handle.

XML

This version of the specification explicitly restricts the OpenXDF headers to UTF-8 or UTF-16 encoding to ensure
maximal compatibility between XML parsers.

Data Storage

Previous versions included a number of artificial limitations left over from the original development. Sample size,
sample frequency, and frame length are no longer constrained, and OpenXDF now includes the ability to specify the
byte order of multi-byte samples.

Montages

Since the specification no longer includes limitations on sampling frequencies, the specification now includes a
minimal set of sampling frequencies for the high- and low-frequency filter types. The specification also includes a
new notch filter requirement.

Previous versions of the specification included a “Type” tag for channels in the montage. This generated a lot of
confusion in the forums since the type names listed were proprietary. In addition, there was some confusion over how
to display events like the XDFviewer using the channel type.

This version of the specification uses standard names for the channel types and includes a table that specifies how
event types relate to channel types.

Patient Information

The patient information section now includes a significant amount of additional information.
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Video

OpenXDF now includes support for referencing video associated with a record.
American Academy of Sleep Medicine Guidelines

OpenXDF now includes support for the new AASM guidelines.

Changes in Version 1.1

XML

§2.1.1.3 of the specification now explicitly requires that systems read and write values using the POSIX locale defined
in IEEE 1003.1, 2004 when not governed by any other requirements. This requirement specifically addresses an issue
that arises when exchanging OpenXDF files between systems using locale settings with conflicting decimal symbols
(“9.345” vs. ©9,345”).

Changes in Version 1.2

XML

§2.1.1.4 of the specification now requires systems that read and write OpenXDF files retain any well-formed,
unrecognized tag’s location within the hierarchy, namespace, name, and contents, and write the tag and its contents
back out verbatim.

Event Display

§3.1.13 is now an optional guideline for consistent event display.

Changes in Version 1.3

Encryption

§2.1.1.2 of the specification now suggests using a random sequence of bytes securely-generated at the time of
encryption as the Initialization Vector for encryption instead of a freshly-generated UUID. While UUIDs are unique
and avoid the problem of reusing a key-1V pair, UUIDs are not cryptographically secure.

Changes in Version 1.4

Corrected formatting errors.
Level 3.PSG

§2.3.2 of the specification no longer includes RERA’s as a defined event and replaces them with Flow Limitations.

Changes in Version 1.5
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Level 1.PSG

Removed the Gender data type and replaced it with a Sex data type that includes the “other” and “unknown” values.
When reading a pre-1.5 OpenXDF file the following mapping shall be used: “male” and “female” Gender values map
directly to the “male” and “female” Sex values. The absence of a Gender value maps to the “unknown” Sex value.
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1 Introduction

The fundamental motivation behind OpenXDF is to provide the medical community with an open standard for the
exchange of time-series data such as electroencephalograph (EEG), electrocardiogram (ECG), and oximetry signals.
The OpenXDF standard also serves as a vehicle for the lightweight exchange of patient- and domain-specific metadata,
such as patient demographics and polysomnography scoring information, with or without signal data.

At its most basic level, an OpenXDF file is a XML-based header file that provides all of the information necessary to
interpret a signal data file. This abstraction allows OpenXDF serve more advanced functions such as being a superset
to existing formats (§2.1.1.5); allowing multiple signal data files, possibility of different formats, to coexist as a single
unit; and metadata exchange.

1.1 Conventions

A byte is a single octet of bits.

The cardinality of an XML tag is a constraint on the number of times a tag may occur within a given context. A
“required” tag shall occur exactly once within a context while an “optional” tag may occur at most once within a
context. The specification will express the cardinality of a tag that may occur more than once within a context using
interval notation.

Figure 1 illustrates the formatting used for XML and code blocks. Blue text indicates an example value.

<xdf :O0penXDF>
<xdf:EpochLength> 30 </xdf:EpochLength>
<xdf:SessionContinuity> false </xdf:SessionContinuity>
<xdf:DataFiles />

</xdf :OpenXDF>

Figure 1 — Example XML Block

1.2 Organization

OpenXDF is a tiered framework designed to allow standardized and custom specializations of the format while
enforcing a common foundation that provides a high-level of compatibility between unrelated systems.

OpenXDF Level 1 defines the absolute minimum requirements for a functional OpenXDF file.
OpenXDF Level 2 defines advanced features common to most specialties.

OpenXDF Level 3 defines specializations of the standard. Level 3 standards contain the name of the specialization to
which they apply. “Level 3.PSG,” for instance, is the standard polysomnography specialization.
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2 Implementation Standards
2.1 Levell

2.1.1 System Requirements

2.1.1.1 Packaging

Systems may package and/or compress one or more OpenXDF headers, as well as any secondary files such as a patient
photo, into a single file using the ZIP file format and the DEFLATE compression algorithm.

When packaged in a ZIP file, systems shall store the main OpenXDF header in the root of the package and name it
“header.xdf.” Later sections will discuss when it is appropriate to package multiple OpenXDF headers and secondary
files together, and discuss how to organize the package in a standard way.

2.1.1.2 Encryption

Systems may encrypt OpenXDF headers or packages using TwoFish in Cipher Feedback (CFB) mode. When
encrypting with TwoFish, systems shall use SHA-256 to hash a plain text, UTF-8 encoded password into a 256-bit
encryption key and use SHA-512 to calculate a 512-bit checksum of the original file.

While TwoFish is a 128-bit block cipher, TwoFish operates as a stream cipher in CFB mode eliminating the need for
a padding scheme to align the input on 128-bit boundaries.

Cipher feedback shall be primed with a 128-bit initialization vector (IV). Since the IV must be public, the IV should
be a random sequence of bytes securely-generated at the time of encryption to avoid security issues related to using
the same key-IV pair more than once.

Encrypted files shall begin with the OpenXDF encryption header shown in Figure 2. All fields are big endian and
aligned on 1-byte boundaries.

OpenXDFEncryptionHeader

{

/* identifies an encrypted OpenXDF header/package; set to 0x53584446. */
UInt32 Magic;

/* size of the header; set to 96 bytes. */
UInt32 HeaderSize;

/* the cipher feedback initialization vector. */
UInt8 InitializationVector[16];

/* SHA-512 hash of the original file. */
UInt8 Checksum[64];

/* Application-specific data. */
UInt64 ApplicationData;

Figure 2 — OpenXDF Encryption Header

Systems shall only apply encryption after packaging/compression.
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2.1.1.3 XML and Entities

Reading systems shall employ an XML parser that adheres to the W3C XML version 1.0 standard. XDFviewer and
maXimus use Microsoft’s free XML Core Services (MSXML) 4.0 to implement a Simple API for XML (SAX) parser.
There are also several open-source, cross-platform parsers available such as eXpat and libxml.

Likewise, writing systems shall write OpenXDF files in a manner that conforms to the XML version 1.0 standard and
shall only use UTF-8 or UTF-16 encoding to ensure maximum compatibility between XML parser implementations.

When not governed by the XML specification, UTF-8/-16, or any specific requirements in this specification (such as
the use of ISO-8601 for date/time values), systems shall read and write values using the POSIX locale defined in
chapter 7 of IEEE 1003.1, 2004.

Systems shall be backward and forward compatible with all versions of the OpenXDF specification starting with
version 1.0.

If this specification does not explicitly indicate the order of list items using a timestamp, epoch number, etc., systems
shall rely on the order in which list items appear in the header. For instance, if “A1” precedes “C3” in the source list

of a signal data file, then “A1” precedes “C3” in the signal data file.

Unless otherwise specified, all values are case-insensitive. For instance, “C3” is the same electrode as “c3.”
2.1.1.4 Unrecognized and Custom Tags

In addition to the standard tags, implementers may also use custom tags. Custom tags shall include an implementation-
specific namespace. Custom tags shall not use the “xdf” namespace.

Reading systems may safely ignore well-formed, but unrecognized, tags. For instance, a system designed to only
understand Level 1 OpenXDF may safely ignore Level 2 tags or custom tags from another implementation.

Systems that read and write OpenXDF files, however, shall retain any well-formed, unrecognized tag’s location within
the hierarchy, namespace, name, and contents, and write the tag and its contents back out verbatim.

2.1.1.5 Data Frames

A data frame is a collection of signal data blocks, aligned on 1-byte boundaries, where each signal data block contains
the same duration of data. The signal data blocks shall be stored in the same order as their sources in the signal data
file’s source list.

While OpenXDF does not constrain the length of a frame, implementers should carefully consider read performance
and display requirements when choosing a frame length. A short frame length may force a reading system to fetch
samples using a large number of small disk operations, while a long frame length may impose limits on epoch length
and display time bases.

For many systems, a one-second frame length provides a good mix of disk access efficiency and display flexibility.

Figure 3 illustrates a typical frame:
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1s Frame

1,000 Hz, 16-bit | [C3 (2,000 bytes)
1,000 Hz, 16-bit: |C4 (2,000 bytes)
1,000 Hz, 16-bit: [AT (2,000 bytes) :

1 Hz, 8-bit: {Sa02 (1 byte) ..next frame

Total Length: 6,001 bytes

Figure 3 — Example Data Frame
2.1.1.6 Digital and Physical Ranges

While not a specific requirement of this specification, implementers should pay particular attention to digital and
physical ranges.

OpenXDF and EDF effectively treat signals as though they have no unit. The EDF header includes a text field for
specifying the unit of a signal. The field is not reliable, however, since it can contain any arbitrary unit or no unit at
all. A signal’s unit value in OpenXDF is simply a convenience for dealing with voltage signals.

Signals without a unit require some care when deciding their physical and digital ranges.

Consider a signal that has a physical range of [ -5 millibars, 5 millibars ]. In EDF, it is possible to specify “mbar” in
the unit field and rely on reading systems to scale the value on the screen appropriately. Doing this, however, assumes
that the reading system understands “mbar.” The reading system may only recognize “mb” or not recognize millbars
at all.

Now consider a system that is able to display one unit per pixel vertically on the screen at a sensitivity of one. Without
any knowledge of the above signal’s unit, the reading system would simply display the signal with a vertical range of
only 10 pixels at a sensitivity of one and less than two pixels at the nominal sensitivity of seven.

If instead, the signal’s range is [ -5000 microbars, 5000 microbars ], the logical equivalent to the same range expressed

in millibars, the reading system would display the signal with a vertical range of 10,000 pixels at a sensitivity of one
since the unit of sensitivity is microbars-per-pixel instead of millibars-per-pixel.

2.1.2 Header Requirements

An OpenXDF header file begins with the standard XML declaration including the XML version and text-encoding
scheme as shown in Figure 4. As specified in §2.1.1.3, the encoding shall either be UTF-8 or UTF-16.

Figure 4 — XML Declaration

2.1.2.1 xdf:OpenXDF Entity

The xdf:OpenXDF entity, shown in Figure 5, immediately follows the XML declaration and is the root element of an
OpenXDF header. The xdf:OpenXDF entity declares the “xdf” namespace as well as any custom namespaces required
by the header.
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<xdf:0penXDF xmlns:xdf="http://www.openxdf.org/xdf"
xmlns:custom="organization/custom"
xmlns:...
>
<xdf:EpochLength> 30 </xdf:EpochLength>
<xdf:SessionContinuity> false </xdf:SessionContinuity>
<xdf:DataFiles />
</xdf :0penXDF>

Figure 5 — xdf:OpenXDF Entity; Level 1

xdf:EpochLength

Data Type: Ulnt8

Cardinality: Optional

Default: See Description

Description: Epoch (page) length in seconds.

This value shall be a common integer multiple of the frame lengths specified
by the data files. An OpenXDF file shall not specify an epoch length that
would force a system to display partial frames in an epoch. The system shall
treat an invalid value as an error and stop processing the file.

If a header does not specify this value, the system shall choose a value that is
a common integer multiple of the frame lengths specified in the data files and
is between 10 and 60 seconds. If any one of the frame lengths exceeds 60
seconds, the epoch length shall be the least common integer multiple of the
frame lengths. The system shall treat the failure to determine a valid epoch
length as an unrecoverable error.

xdf:SessionContinuity

Data Type: Boolean

Cardinality: Optional

Default: False

Description: Indicates how systems shall calculate epoch numbers across sessions. If this

value is true, systems shall take the time between sessions into account when
calculating epoch numbers.

For example, consider Session A and Session B, and an epoch length of 30
seconds. If Session A is one hour long, Session B begins one hour after
Session A ends and this value is true, the first epoch of Session B would be
241 instead of 121.

xdf:DataFiles

Data Type: List of DataFile entities; [0, +o0)

Cardinality: Optional

Default: No default

Description: Defines a list of signal data files referenced by the header.

2.1.2.2 xdf:DataFile Entity

5|Page



<xdf:DataFile>
<xdf:File> EXAMPLE.RAWDATA </xdf:File>
<xdf:FrameLength> 1 </xdf:FrameLength>
<xdf:Endian> big </xdf:Endian>
<xdf:Sources />
<xdf:Sessions />

</xdf:DataFile>

Figure 6 — xdf:DataFile Entity; Level 1

Data Type: Text

Cardinality: Required

Default: No default

Description: The signal data file name. To avoid path convention issues across platforms,

systems should avoid absolute and/or complex paths such as UNC paths and
URLs. Systems shall attempt to translate between Windows and POSIX
conventions where possible.

Data Type: Floating-point

Cardinality: Required

Default: No default

Description: The data frame length in seconds. Systems shall treat a value less than or equal

to zero as an unrecoverable error. See §2.1.1.5.

Data Type: Endian

Cardinality: Optional

Default: “little”

Description: Specifies the byte order of multi-byte samples.

xdf:Sources

Data Type: List of Source entities; [0, +o0)

Cardinality: Optional

Default: No default

Description: Defines a list of sources in the signal data file.

xdf:Sessions

Data Type: List of Session entities; [1, +o0)

Cardinality: Required

Default: No default

Description: Defines a list of recording sessions in the signal data file. Sessions shall be

disjoint across all DataFile entities specified in the header.

2.1.2.3 xdf:Source Entity
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<xdf:Source>

<xdf:Ignore> false </xdf:Ignore>

<xdf:SourceName> (3 </xdf:SourceName>

<xdf:Signed> true </xdf:Signed>

<xdf:SampleWidth> 2 </xdf:SampleWidth>

<xdf:SampleFrequency> 1000 </xdf:SampleFrequency>

<xdf:DigitalMin> -32768 </xdf:DigitalMin>

<xdf:PhysicalMax> 3200 </xdf:PhysicalMax>

<xdf:PhysicalMin> -32600 </xdf:PhysicalMin>

<xdf:DigitalToVolts> 0.09765774 </xdf:DigitalToVolts>

<xdf:Unit> 0.000001 </xdf:Unit>

</xdf:Source>

Figure 7 — xdf:Source Entity

; <xdf:DigitalMax> 32767 </xdf:DigitalMax> 3

Data Type: Boolean

Cardinality: Optional

Default: False

Description: Indicates whether systems shall ignore the source.

Headers shall specify the SourceName, SampleWidth, and SampleFrequency
for ignored sources. The SampleWidth and SampleFrequency values may be
arbitrary as long as their product equals the correct number of bytes in a frame
to skip.

Data Type: Text

Cardinality: Required

Default: No default

Description: A name that uniquely identifies this source within this DataFile entity.

Systems shall treat any subsequent sources with a duplicate name as though
their ignore flags are set to true.

Data Type: Boolean

Cardinality: Optional

Default: True

Description: Indicates whether samples are signed or unsigned.
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xdf:

Data Type: Ulnt8

Cardinality: Required

Default: No default

Description: Sample size in bytes. Systems shall support sample sizes up to the integer size

of their target architectures. For example, 32-bit systems shall support up to
32-bit (4 byte) samples, but are not required to support larger samples.

If a system encounters a sample size it does not support, the system shall treat
the source as though xdf:Ignore is true.

Systems shall treat a value of zero as an unrecoverable error.

Data Type: Ulnt16

Cardinality: Required

Default: No default

Description: The sampling frequency, in Hz, for this source.

Systems shall treat a value of zero as an unrecoverable error.

Data Type: Floating-point

Cardinality: Required

Default: No default

Description: Maximum value of the digital signal. See §2.1.1.6.
Data Type: Floating-point

Cardinality: Required

Default: No default

Description: Minimum value of the digital signal. See §2.1.1.6.
Data Type: Floating-point

Cardinality: Required

Default: No default

Description: Maximum value of the physical signal. See §2.1.1.6.

xdf: PhysicalMin

Data Type: Floating-point

Cardinality: Required

Default: No default

Description: Minimum value of the physical signal. See §2.1.1.6.
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xdf:DigitalToVolts

Data Type: Floating-point

Cardinality: Optional

Default: 1.0

Description: Specifies a multiplier that systems may use to convert the digital range of a

non-Voltage signal to Volts.

Consider an amplifier with a DC input that outputs 0.01V increments
represented by signed, 8-bit samples. The full range of the input is:
[-128, 127] =[-1.28V, 1.27V].

Now consider a CPAP machine that outputs OV to 1V representing 0 cmH20,
30 cmH20. To display the data properly, the OpenXDF source would need a
physical min and max of 0 and 30 respectively, and a digital min and max
would be 0 and 100 respectively.

In this case, the xdf:DigitalToVolts value would 0.01.

Data Type: Floating-point

Cardinality: Optional

Default: 0.0

Description: Specifies the unit of a calibrated physical signal as a factor of Volts. For
instance, 0.001 represents millivolts. For non-Voltage signals, this value shall
be 0.0.

2.1.2.4 xdf:Session Entity

<xdf:Session>
<xdf:0ffset> 1000 </xdf:0ffset>
<xdf:Length> 7201200 </xdf:0ffset>
<xdf:StartTime> 2008-07-015T22:00:00.250-04:00 </xdf:StartTime>

</xdf:Session>

'
L

Figure 8 — xdf:Session Entity; Level 1

Data Type: Ulnt64

Cardinality: Required

Default: No default

Description: Specifies the offset, in bytes, from the beginning of the signal data file to the

start of the session data.

Data Type: Ulnt64

Cardinality: Required

Default: No default

Description: Specifies the length, in bytes, of the session’s signal data.
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xdf:StartTime
Data Type: Date/Time
Cardinality: Required
Default: No default
Description: Specifies session’s start date and time.

2.2 Level 2

2.2.1 System Requirements

A level 2 compliant system shall adhere to all requirements in §2.1.1 and introduces the following requirements.

2.2.1.1 Packaging

”

Systems may package patient photos into a package directory named “photos.” The names of the photos may be
arbitrary as long as they are unique within the “photos” directory. For maximum compatibility, systems should store
patient photos as JPEGs.

2.2.1.2 Montaging

When implementing a montage interface, systems shall provide the user with a ground source. Systems shall always
refer to this implied ground source as “GND” and shall not include it in the source list. The ground source shall always
be zero, i.e. GND — C3 is equivalent to 0 — C3.

Systems shall provide the minimal sets of low- and high-frequency filters specified in §3.1.5 and §3.1.6 respectively.
These filters shall support the following discrete set of sampling frequencies (in Hz) typically used in PSG and EEG
studies:

1 5 10

25 50 100
200 250 256
500 512 1,000
10,000

Systems should also provide both 50 Hz and 60 Hz notch filters for sampling frequencies in the above set greater than
or equal to 200 Hz.

Systems shall ignore filter settings for signals sampled at frequencies outside of the system’s supported set.
Implementers may choose how to handle invalid filter cutoff frequency and signal sampling frequency combinations.
For instance, an implementer may choose to use a null filter to zero a channel if the montage specifies a 53 Hz low-
frequency filter on a 25 Hz signal. Likewise, an implementer may choose to use an identity filter if the montage
specifies a 35 Hz high-frequency filter on a 25 Hz signal.

2.2.2 Header Requirements
A level 2 compliant format shall adhere to all requirements in §2.1.2 and introduces the following requirements.

2.2.2.1 Instantaneous Event

The Instantaneous Event entity is the common basis for events that do not have duration.
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<Instantaneous Event>

; <xdf:Time> 2008-07-015T22:05:00.123-04:00 </xdf:Time> ;
. </Instantaneous Event> !

Figure 9 — Instantaneous Event

Data Type: Date/Time

Cardinality: Required

Default: No default

Description: Specifies the date and time at which the event occurred.

2.2.2.2 Non-instantaneous Event

The Non-instantaneous Event entity is the common basis for events that have duration.

<Non-instantaneous Event>
<!-- Instantaneous Event Information -->
<xdf:Duration> 5 </xdf:Duration>
</Non-instantaneous Event>

Figure 10 — Non-instantaneous Event

Data Type: Floating-point

Cardinality: Required

Default: No default

Description: Specifies the duration of the event.

2.2.2.3 Staff

The Staff entity is the common basis for information about staff members.
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<Staff Member>
<xdf:FirstName> Joe </xdf:FirstName>
<xdf:LastName> Technician </xdf:LastName>
<xdf:MiddleName> Bob </xdf:MiddleName>
<xdf:ID> 1515 </xdf:ID>
<xdf:WorkPhone> 1|352|555-0000| 312 </xdf:WorkPhone>
<xdf:Pager />

<xdf:CellPhone />

<xdf:Email> joebob@sleeplab.com </xdf:Email>
<xdf:Specialty />

<xdf:Titlel> RPSGT </xdf:Titlel>

<xdf:Title2 />

<xdf:Title3 />

E <xdf:Fax />
E </Staff Member>

Figure 11 — Staff

Data Type: Text

Cardinality: Optional

Default: No default

Description: The staff member’s first name.

Data Type: Text

Cardinality: Optional

Default: No default

Description: The staff member’s last name.

Data Type: Text

Cardinality: Optional

Default: No default

Description: The staff member’s middle name.
xdf:I1D

Data Type: Text

Cardinality: Optional

Default: No default

Description: The staff member’s organizational ID.

Data Type: Phone Number

Cardinality: Optional

Default: No default

Description: The staff member’s work phone number.
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Data Type: Phone Number

Cardinality: Optional

Default: No default

Description: The staff member’s pager number
xdf:Fax

Data Type: Phone Number

Cardinality: Optional

Default: No default

Description: The staff member’s fax number

xdf:CellPhone

Data Type: Phone Number

Cardinality: Optional

Default: No default

Description: The staff member’s cell phone number.
Data Type: Text

Cardinality: Optional

Default: No default

Description: The staff member’s email address.
Data Type: Text

Cardinality: Optional

Default: No default

Description: The staff member’s specialty.
Data Type: Text

Cardinality: Optional

Default: No default

Description: Free-form staff member title.
Data Type: Text

Cardinality: Optional

Default: No default

Description: Free-form staff member title.
Data Type: Text

Cardinality: Optional

Default: No default

Description: Free-form staff member title.

2.2.2.4 xdf:OpenXDF Entity
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<xdf:0penXDF xmlns:xdf="http://www.openxdf.org/xdf"
xmlns:custom="organization/custom"
xmlns:...

>

<xdf:PatientInformation />
<xdf:NoteLog />
<xdf:Video />

; <!-- Level 1 Information --> 3
| </xdf:0penXDF> 3

Figure 12 — xdf:OpenXDF Entity; Level 2

xdf:PatientInformation

Data Type: PatientInformation entity

Cardinality: Optional

Default: No default

Description: Specifies information about the patient.
Data Type: List of Note entities; [0, +o0)
Cardinality: Optional

Default: No default

Description: Defines a global list of annotations.
Data Type: Video entity

Cardinality: Optional

Default: No default

Description: Specifies information about associated video clips.

2.2.2.5 xdf:DataFile Entity

<xdf:DataFile>
<!-- Level 1 Information -->
<xdf:Montages />
<xdf:RevMontages />
</xdf:DataFile>

Figure 13 — xdf:DataFile Entity; Level 2

Data Type: List of Montage entities; [0, +o0)

Cardinality: Optional

Default: No default

Description: Defines a list of montages used during recording.
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Data Type: List of Montage entities; [0, +o0)

Cardinality: Optional

Default: No default

Description: Defines a list of display montages used during review. Unlike recording
montages, it is generally acceptable to only keep the last used review montage.

2.2.2.6 xdf:Session Entity

<xdf:Session>
<!-- Level 1 Information -->
<xdf:SyncMarkers />
</xdf:Session>

Figure 14 — xdf:Session Entity; Level 2

Data Type: List of SyncMarker entities; [0, +o0)
Cardinality: Optional

Default: No default

Description: Defines a list of data synchronization markers.

2.2.2.7 xdf:Montage Entity

<xdf :Montage>
<xdf:EffectiveTime> 2008-07-15T722:00:00.250-04:00 </xdf:EffectiveTime>
<xdf:Channels />

</xdf :Montage>

Figure 15 — xdf:Montage Entity

Data Type: Date/Time

Cardinality: Required

Default: No default

Description: The date and time at which the montage took effect.
Data Type: List of Channel entities; [0, +o0)

Cardinality: Optional

Default: No default

Description: Defines a list of channels.

2.2.2.8 xdf:Channel Entity
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<xdf:Channel>

<xdf:Gl> C3 </xdf:G1l>

<xdf:G2> A2 </xdf:G2>

<xdf:
<xdf:

<xdf:HF> 0.53] </xdf:HF>

<xdf:LF> 35 </xdf:LF>

</xdf :Channel>

Label> C3/A2 </xdf:Label>

Sensitivity> 7 </xdf:Sensitivity>

Figure 16 — xdf:Channel Entity; Level 2

Data Type: Text

Cardinality: Optional

Default: “GND”

Description: Specifies the source to which systems shall reference G2.
xdf:G2

Data Type: Text

Cardinality: Optional

Default: “GND”

Description: Specifies the G2 source for the channel.

Data Type: Text

Cardinality: Optional

Default: The system shall choose a default label that includes the names of the sources

specified by G1 and G2.

Description: Specifies a label for the channel.

Data Type: Sensitivity

Cardinality: Optional

Default: 0

Description: Specifies the channel sensitivity.
xdf:LF

Data Type: Low Frequency Filter

Cardinality: Optional

Default: 0

Description: Specifies the low frequency filter for the channel.
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xdf:HF
Data Type: High Frequency Filter
Cardinality: Optional
Default: 0
Description: Specifies the high frequency filter for the channel.

2.2.2.9 xdf:PatientInformation Entity

17|Page



<xdf:PatientInformation>
<xdf:FirstName> 7Tim </xdf:FirstName>
<xdf:LastName> Newnan </xdf:LastName>
<xdf:MiddleName> John </xdf:MiddleName>
<xdf:ID> 111-22-3333 </xdf:ID>
<xdf:DOB> 1979-04-22 </xdf:DOB>
<xdf:Sex> male </xdf:Sex>
<xdf:Weight> 200 </xdf:Weight>
<xdf:WeightUnits> Ib </xdf:WeightUnits>
<xdf:Height> 71 </xdf:Height>
<xdf:HeightUnits> in </xdf:HeightUnits>
<xdf:DominantHand> right </xdf:DominantHand>
<xdf:Street> 111 Magnolia Place </xdf:Street>
<xdf:City> Gainesville </xdf:City>
<xdf:State> FL </xdf:State>
<xdf:Country> United States </xdf:Country>
<xdf:ZipCode> 32608 </xdf:ZipCode>
<xdf:HomePhone> 1|352|555-0001 </xdf:HomePhone>
<xdf:WorkPhone> 1|352|555-0002|312 </xdf:WorkPhone>
<xdf:EmergPhone />
<xdf:Fax />
<xdf:Pager />
<xdf:CellPhone />
<xdf:Email />
<xdf:Codes> 327.23, 333.94 </xdf:Codes>
<xdf:Comments> This is a comment. </xdf:Comments>
<xdf:TestDescription> Tested for sleep disorders. </xdf:TestDescription>
<xdf:Medication> Ambien, Coumadin </xdf:Medication>
<xdf:Interpretation> Patient had abnormal sleep. </xdf:Interpretation>
<xdf:Recommendations> Patient needs CPAP. </xdf:Recommendations>
<xdf:FollowupPlans> Will followup with CPAP study. </xdf:FollowupPlans>
<xdf:PatientOpinion> Patient concerned about CPAP tolerance. </xdf:PatientOpinion>
<xdf:Physician />
<xdf:Technician />
<xdf:Referring />
<xdf:0rdering />
<xdf:Reading />
</xdf:PatientInformation>

Figure 17 — xdf:PatientInformation Entity

xdf:FirstName

Data Type: Text

Cardinality: Optional

Default: No default
Description: The patient’s first name.
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Data Type: Text

Cardinality: Optional

Default: No default

Description: The patient’s last name.

Data Type: Text

Cardinality: Optional

Default: No default

Description: The patient’s middle name.

Data Type: Text

Cardinality: Optional

Default: No default

Description: The patient’s organizational ID.
xdf:DOB

Data Type: Date

Cardinality: Optional

Default: No default

Description: The patient’s date of birth.
xdf:Sex

Data Type: Sex

Cardinality: Optional

Default: “unknown”

Description: The patient’s sex.

xdf:Weight

Data Type: Floating-point
Cardinality: Optional

Default: 0.0

Description: The patient’s weight.
Data Type: Weight Unit

Cardinality: Optional

Default: “Ib”

Description: Weight measurement unit.

xdf:Height

Data Type: Floating-point
Cardinality: Optional

Default: 0.0

Description: The patient’s height.
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Data Type: Height Unit

Cardinality: Optional

Default: “in”

Description: Height measurement unit.

xdf:DominantHand

Data Type: Dominant Hand

Cardinality: Optional

Default: No default

Description: The patient’s dominant hand.
Data Type: Text

Cardinality: Optional

Default: No default

Description: The patient’s street address.
Data Type: Text

Cardinality: Optional

Default: No default

Description: The patient’s city of residence.
Data Type: Text

Cardinality: Optional

Default: No default

Description: The patient’s state of residence.
Data Type: Text

Cardinality: Optional

Default: No default

Description: The patient’s country of residence.
Data Type: Text

Cardinality: Optional

Default: No default

Description: The patient’s postal code.

Data Type: Phone Number

Cardinality: Optional

Default: No default

Description: The patient’s home phone number.
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Data Type: Phone Number

Cardinality: Optional

Default: No default

Description: The patient’s work phone number.
xdf:EmergPhone

Data Type: Phone Number

Cardinality: Optional

Default: No default

Description: The patient’s emergency contact phone number.

Data Type: Phone Number

Cardinality: Optional

Default: No default

Description: The patient’s fax number.

Data Type: Phone Number

Cardinality: Optional

Default: No default

Description: The patient’s pager number

Data Type: Phone Number

Cardinality: Optional

Default: No default

Description: The patient’s cell phone number.

Data Type: Text

Cardinality: Optional

Default: No default

Description: The patient’s email address.

Data Type: Text

Cardinality: Optional

Default: No default

Description: Defines a comma-separated list of diagnosis codes.

Data Type: Text

Cardinality: Optional

Default: No default

Description: Free-form comment.
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xdf: TestDescription

Data Type: Text

Cardinality: Optional

Default: No default

Description: Free-form description of the test.
Data Type: Text

Cardinality: Optional

Default: No default

Description: Defines a comma-separated list of medications.
Data Type: Text

Cardinality: Optional

Default: No default

Description: Free-form interpretation of the test.
Data Type: Text

Cardinality: Optional

Default: No default

Description: Free-form recommendations

Data Type: Text

Cardinality: Optional

Default: No default

Description: Free-form follow-up plans

xdf:PatientOpinion

Data Type: Text

Cardinality: Optional

Default: No default

Description: Free-form patient opinion about the test.

Data Type: Staff entity

Cardinality: Optional

Default: No default

Description: Specifies information about the patient’s primary physician.
Data Type: Staff entity

Cardinality: Optional

Default: No default

Description: Specifies information about the technician that ran the test.
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xdf:Referring

Data Type: Staff entity

Cardinality: Optional

Default: No default

Description: Specifies information about the patient’s referring physician.
Data Type: Staff entity

Cardinality: Optional

Default: No default

Description: Specifies information about the physician that ordered the test.
Data Type: Staff entity

Cardinality: Optional

Default: No default

Description: Specifies information about the physician that read the test.

2.2.2.10 xdf:Note Entity

<xdf:Note>

<!-- Instantaneous Event Information -->

<xdf:NoteText> Lights-out </xdf:NoteText>

</xdf :Note>

Figure 18 — xdf:Note Entity

Data Type: Text

Cardinality: Required

Default: No default
Description: Free-form annotation.

2.2.2.11 xdf:Video Entity

<xdf:Video>
<xdf:VideoClips />
<xdf:NoteLog />

</xdf:Video>

_____________________________________

Figure 19 — xdf:Video Entity

Data Type: List of VideoClip entities; [0, +0)
Cardinality: Optional

Default: No default

Description: Defines a list of associated video clips.
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xdf:NoteLog
Data Type: List of Note entities; [0, +o0)
Cardinality: Optional
Default: No default
Description: Defines a list of video annotations.

2.2.2.12 xdf:VideoClip Entity

<xdf:VideoClip>
<!-- Non-instantaneous Event Information -->
<xdf:ClipFile> video/clipl.wmv </xdf:ClipFile>
<xdf:ClipComment> Seizure Event </xdf:ClipComment>
</xdf:VideoClip>

Figure 20 — xdf:VideoClip Entity

xdf:ClipFile

Data Type: Text

Cardinality: Required

Default: No default

Description: The video clip file name. To avoid path convention issues across platforms,

systems should avoid absolute and/or complex paths such as UNC paths and
URLs. Systems shall attempt to translate between Windows and POSIX
conventions where possible.

xdf:ClipComment

Data Type: Text

Cardinality: Optional

Default: No default
Description: Free-form comment.

2.2.2.13 xdf:SyncMarker Entity

<xdf:SyncMarker>
<!-- Instantaneous Event Information -->
<xdf:SyncDelta> 0.0012 </xdf:SyncDelta>
</xdf:SyncMarker>

Figure 21 — xdf:SyncMarker Entity
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xdf:SyncDelta

Data Type: Floating-point

Cardinality: Required

Default: No default

Description: Indicates acquisition device drift in seconds. A positive value indicates that

the acquisition device was running faster than its nominal sampling rate. A
negative value indicates that the acquisition device was running slower than
its nominal sampling rate.

2.3 Level 3.PSG

2.3.1 System Requirements

A level 3.PSG compliant system shall adhere to all requirements in §2.2.1 and introduces the following requirements.

2.3.1.1 Packaging

Systems may package scoring results into secondary headers under a package directory named “scoring.” The file
names of the secondary headers may be arbitrary but shall be unique within the “scoring” directory. Each secondary
header may contain one or more scorers; however, the scorer IDs shall be unique across all secondary headers in the
package.

2.3.2 Header Requirements
A level 3.PSG compliant format shall adhere to all requirements in §2.2.2 and introduces the following requirements.

2.3.2.1 Respiratory Event

The Respiratory Event entity is the common basis for classified respiratory events.

<Respiratory Event>
<!-- Non-instantaneous Event Information -->
<xdf:Class> obstructive </xdf:Class>
</Respiratory Event>

Figure 22 — Respiratory Event Entity

xdf:Class

Data Type: Respiratory Class

Cardinality: Required

Default: No default

Description: Specifies the respiratory event class.

2.3.2.2 xdf:OpenXDF Entity
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<xdf:0penXDF xmlns:xdf="http://www.openxdf.org/xdf"

xmlns:...

xmlns:custom="organization/custom"

<!-- Level 2 Information -->

<xdf:ScoringResults />

</xdf :OpenXDF>

E >

Figure 23 — xdf:OpenXDF Entity; Level 3.PSG

xdf:ScoringResults

Data Type: ScoringResults entity
Cardinality: Optional

Default: No default

Description: Specifies scoring results.

2.3.2.3 xdf:Channel Entity

<xdf:Channel>

</xdf:Channel>

<!-- Level 2 Information -->

<xdf:Type> Pressure </xdf:Type>

Figure 24 — xdf:Channel Entity; Level 3.PSG

xdf:Type
Data Type: Channel Type
Cardinality: Optional
Default: No default
Description: Channel type

2.3.2.4 xdf:ScoringResults Entity

<xdf:ScoringResults>
<xdf:EpochInformation>
<xdf:Scorers>

</xdf:ScoringResults>

Figure 25 — xdf:ScoringResults Entity

xdf:EpochInformation
Data Type: List of Epoch entities; [0, +o0)
Cardinality: Optional
Default: No default
Description: Defines a list of scorer-independent epoch information.
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Data Type: List of Scorer entities; [0, +0)
Cardinality: Optional

Default: No default

Description: Defines a list of scorers.

2.3.2.5 xdf:Epoch Entity

i <xdf:Epoch> ;
; <xdf :EpochNumber> 546 </xdf:EpochNumber> 3
! </xdf:Fpoch> ;

Figure 26 — xdf:Epoch Entity

xdf:EpochNumber

Data Type: Ulnt32

Cardinality: Required

Default: No default

Description: Specifies the epoch number to which this information applies.

2.3.2.6 xdf:Scorer Entity

<xdf:Scorer>
<xdf:ScorerID> 9BC7C81D-9D2D-4685-B08E-0B334F858299 </xdf:ScorerID>
<xdf:FirstName> Alice </xdf:FirstName>
<xdf:LastName> de Scorer </xdf:LastName>
<xdf:SleepStages />
<xdf:Apneas />
<xdf:Hypopneas />

i <xdf:FlowLimitations /> i
E <xdf:Desaturations /> ;
i <xdf:Microarousals /> i
; <xdf:Snores /> E
i <xdf:LegMovementsl /> i
E <xdf:LegMovements2 /> E
i <xdf:NoteLog /> i
E </xdf:Scorer> E

Figure 27 — xdf:Scorer Entity

xdf:ScorerID

Data Type: UUID

Cardinality: Required

Default: No default

Description: Specifies a universally unique ID for the scorer.
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xdf:

xdf:

Data Type: Text

Cardinality: Optional

Default: No default
Description: The scorer’s first name.
Data Type: Text

Cardinality: Optional

Default: No default
Description: The scorer’s last name.

Data Type: List of SleepStage entities; [0, +o0)
Cardinality: Optional

Default: No default

Description: Defines a list of sleep stages.

xdf:

Apneas

Data Type: List of Apnea entities; [0, +o0)
Cardinality: Optional

Default: No default

Description: Defines a list of apneas.

xdf:

Hypopneas

Data Type: List of Hypopnea entities; [0, +o)
Cardinality: Optional

Default: No default

Description: Defines a list of hypopneas.

xdf:

FlowLimitations

Data Type: List of FlowLimitation entities; [0, +0)
Cardinality: Optional

Default: No default

Description: Defines a list of flow limitations.

xdf:

Desaturations

Data Type: List of Desaturation entities; [0, +o0)
Cardinality: Optional

Default: No default

Description: Defines a list of O2 desaturations.

xdf:

Data Type: List of Microarousal entities; [0, +o0)
Cardinality: Optional

Default: No default

Description: Defines a list of microarousals.
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Data Type: List of Snore entities; [0, +o0)
Cardinality: Optional
Default: No default
Description: Defines a list of snores.
xdf:LegMovementsl
Data Type: List of LegMovement entities; [0, +o0)
Cardinality: Optional
Default: No default
Description: Defines a list of leg movements on the first leg channel
Data Type: List of LegMovement entities; [0, +o0)
Cardinality: Optional
Default: No default
Description: Defines a list of leg movements on the second leg channel
Data Type: List of Note entities; [0, +o0)
Cardinality: Optional
Default: No default
Description: Defines a list of scorer-dependent annotations.

2.3.2.7 xdf:SleepStage Entity

<xdf:SleepStage>
<xdf:EpochNumber> 342 </xdf:EpochNumber>
<xdf:Stage> R </xdf:Stage>
</xdf:SleepStage>

Figure 28 — xdf:SleepStage Entity

Data Type: Ulnt32

Cardinality: Required

Default: No default

Description: The epoch number to which this sleep stage applies.
Data Type: Sleep Stage

Cardinality: Optional

Default: “N”

Description: Specifies the sleep stage for this epoch.

2.3.2.8 xdf:Apnea Entity
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<xdf :Apnea>

E <!-- Respiratory Event Information -->
| </xdf:Apnea>

Figure 29 — xdf:Apnea Entity

2.3.2.9 xdf:Hypopnea Entity

<xdf:Hypopnea>

] <!-- Respiratory Event Information --> '
E </xdf :Hypopnea> E

Figure 30 — xdf:Hypopnea Entity

2.3.2.10 xdf:FlowLimitation Entity

<xdf:FlowLimitation>
<!-- Respiratory Event Information -->

</xdf:FlowLimitation>

Figure 31 — xdf:FlowLimitation Entity

2.3.2.11 xdf:Desaturation Entity

<xdf:Desaturation>

; <!-- Non-instantaneous Event Information -->
' </xdf:Desaturation>

Figure 32 — xdf:Desaturation Entity

2.3.2.12 xdf:Microarousal Entity

<xdf:Microarousal>
<!-- Non-instantaneous Event Information -->
</xdf:Microarousal>

Figure 33 — xdf:Microarousal Entity

2.3.2.13 xdf:Snore Entity

<xdf:Snore>
<!-- Non-instantaneous Event Information -->

</xdf:Snore>

Figure 34 — xdf:Snore Entity



2.3.2.14 xdf:LegMovement Entity

<xdf:LegMovement>

p <!-- Non-instantaneous Event Information --> '
i </xdf:LegMovement> ;

Figure 35 — xdf:LegMovement Entity
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3 Data Types

3.1.1 Fundamental Data Types

Type Range

Boolean { “true”, “false” }

(S/U)Int8 (S)igned/(U)nsigned 8 bits
(S/U)Int16 (S)igned/(U)nsigned 16 bits
(S/U)Int32 (S)igned/(U)nsigned 32 bits
(S/U)Int64 (S)igned/(U)nsigned 64 bits
Floating-point Platform specific.

3.1.2 Endian Type

The Endian type describes the byte order of a multi-byte value. Little endian values proceed from the least-significant
byte to the most significant, whereas big endian values proceed from the most-significant byte to the least significant.
The Endian type may be one of the following values:

“big” “little”
3.1.3 Date/Time Type

A date/time value shall adhere to the following subset of ISO 8601.

A time shall be qualified with a date; however, a date does not have to include a time. If a date does not include a
time, the time shall default to 00:00:00 UTC.

Dates always include four-digit years and leading zeros on the month and day. A dash (“-”) separates the year, month,
and day.

Systems shall pay particular attention to the ability to represent arbitrary dates using ISO 8601. Systems may not rely
on an internal date/time representation that uses a starting epoch or is limited in range to the near future.

A date and the character “T” shall precede time values. Systems shall always specify time values in 24-hour format
with leading zeros on the hour, minute, and second. Fractions of a second may be expressed using a decimal point
(““.”) after the seconds. A colon (“:”) separates the hour, minute, and second.

Systems shall support up to one microsecond precision.
Time zone offsets start with “+” or “-” character followed by the offset in hours and minutes with leading zeros and
separated by a “:”. Using “Z” instead of a time zone offset indicates Coordinated Universal Time (UTC). If a time
does not include either an offset or a “Z” character, the time zone shall default to UTC.

YROOB=07=15" cccoccocccccooonoocooooccoooooo 00:00:00 +000 ms AM UTC, July 15, 2008
*2008-07-15T22:00:00.000250” .............. 10:00:00 +250 us PM UTC, July 15, 2008
“2008-07-15T22:00:00.000250Z2"” ............. 10:00:00 +250 us PM UTC, July 15, 2008
“2008-07-15T22:00:00.250-04:00" ........... 10:00:00 +250 ms PM EDT/CST, July 15, 2008

Figure 36 — Example Date/Time Values

3.1.4 Sensitivity Type
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Traditionally, this value would specify the sensitivity in uV / mm. Systems shall interpret this value as simply a divider.
A sensitivity of zero indicates that the system should zero the channel.

Systems shall support the following values typically used in PSG and EEG studies:

0 1 2

3 5 7
10 15 20
30 40 50
75 80 100
150 200

3.1.5 Low Frequency Filter Type

Systems shall support the following low frequency cutoffs (in Hz) typically used in PSG and EEG studies and specified
by the AASM:

0.032 0.053 0.1
0.159 0.3 0.531
1.592 5.305 10
15.916 53.052

Some of these values represent the typical set of low-frequency filter time constants, which are: Ss, 3s, 1s, 0.3s, 0.1s,
0.03s, and 0.003s.

1

T=——
2 7T fcutoﬂ'
Figure 37 — Time Constant / Cutoff Frequency Relationship

3.1.6 High Frequency Filter Type

Systems shall support the following high frequency cutoffs (in Hz) typically used in PSG and EEG studies:

15 30 35
60 70 100

3.1.7 Sex Type

Sex may be one of the following values:

“male” “female” “other”
“unknown”

3.1.8 Weight Unit Type

The weight unit may be one of the following values:

“lb” “kg”
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3.1.9 Height Unit Type

The height unit may be one of the following values:

[T39e L] 113 2

m cm

3.1.10 Dominant Hand Type

The dominant hand may be one of the following values:

“left” ccright”

3.1.11 Phone Number Type

The phone number type is a text value that contains the country code, area code, subscriber number, and extension
separated by the pipe (“|’) character.

Y1352 555=0000( 312” ccccococoocoosoooscoocs +1 (352) 555-0000 x312
Y39)06( 12345678 (3127 cccoccooooocooocooocooco +39 06 12345678 x312
N44120112345678 3127 ... ... e +44 20 12345678 x312

Figure 38 — Example Phone Numbers
3.1.12 UUID Type

The UUID type is a Universally Unique Identifier that adheres to RFC 4122.

“9BC7C81D-9D2D-4685-B08E-0B334F858299”
“873491BA-5A2C-407F-B608-A02DA601D076"
“B63CA4D8-F74F-4DD3-A9A3-82E0D1E4F517"”

Figure 39 — Example UUIDs

3.1.13 Channel Type

The channel type serves two purposes. First, it indicates where reading systems should display each type of event.
Second, it serves as a hint for computer scoring system as to how the system should interpret the channel. The channel
type may be one of the following values:

“Central” “Occipital” “Frontal”

“EOG1” “EOG2” “EKG1”

“EKG2” “EKG3” “Chin”

“Legl” “Leg2” “Therm.” (Thermister)
“Press.” (Pressure Transducer) “C.Flow” (CPAP Flow) “Chest” (Chest Effort)
“Abdomen” (Abdominal Effort) “Sa02” “Snore”

“Body” (Body Position) “Pulse” “EtCO2”

“RR” (R-to-R Interval) “pH” “BP” (Blood Pressure)
“PTT” (Pulse Transit Time) “CPAP” (CPAP Pressure)

Reading systems should display events according to the following rules:
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Event Type Channel Type

Apneas Systems should display apneas on the Thermister channel. If a Thermister channel is not
present in the montage, systems may display apneas on the Pressure channel if present.

Hypopneas Systems should display hypopneas on the Pressure channel. If a Pressure channel is not

present in the montage, systems may display hypopneas on the Thermister channel if
present.

Flow Limitations

Systems should display flow limitations on the Chest channel.

Leg Movements

Systems should display leg movements on either the Legl or Leg2 channel depending
on the leg movement list in which the event exists (xdf:LegMovementsl or

xdf:LegMovements2).
Snores Systems should display snores on the Snore channel.
Desaturations Systems should display desaturations on the SaO2 channel.
Microarousals Systems should display microarousals on any available EEG or EOG channel (Central,

Occipital, Frontal, EOG1, or EOG2).

3.1.14 Sleep Stage Type

The sleep stage type may be

one of the following values:

“1”/ Stage 1 or AASM N1 “2” / Stage 2 or AASM N2 “3” / Stage 3 or AASM N3
“4” / Stage 4 or AASM N3 “R”/REM “A” / Infant Active

“T” / Infant Transitional “Q” / Infant Quiet “W” / Wake

“M” / Movement “L” / Lights-on “TR”/ Tech-in-Room

“N” / No-data

“NR” / AASM Infant Non-REM

3.1.15 Respiratory Class Type

The respiratory class may be one of the following values:

“obstructive”

“mixed” “central”
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4 Putting It All Together: A Full Example
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<?xml version="1.0" encoding="utf-8" 2>
<xdf:0penXDF xmlns:xdf="http://www.openxdf.org/xdf"
xmlns:custom="http://www.example.org/custom">
<xdf :EpochLength> 30 </xdf:EpochLength>
<xdf:SessionContinuity> false </xdf:SessionContinuity>
<xdf:PatientInformation>
<xdf:FirstName> Tim </xdf:FirstName>
<xdf:MiddleName> John </xdf:MiddleName>
<xdf:LastName> Newnan </xdf:LastName>
<xdf:ID> 111-22-3333 </xdf:ID>
<xdf:DOB> 1979-04-22 </xdf:DOB>
<xdf:Sex> male </xdf:Sex>
<xdf:Weight> 200 </xdf:Weight>
<xdf:WeightUnits> Ib </xdf:WeightUnits>
<xdf:Height> 71 </xdf:Height>
<xdf:HeightUnits> in </xdf:HeightUnits>
<xdf:DominantHand> right </xdf:DominantHand>
<xdf:Street> 111 Magnolia Place </xdf:Street>
<xdf:City> Gainesville </xdf:City>
<xdf:State> FL </xdf:State>
<xdf:Country> United States </xdf:Country>
<xdf:ZipCode> 32608 </xdf:ZipCode>
<xdf :HomePhone> 1|352|555-0001 </xdf:HomePhone>
<xdf:WorkPhone> 1|352|555-0002|313 </xdf:WorkPhone>
<xdf:EmergPhone />
<xdf:Fax />
<xdf:Pager />
<xdf:CellPhone />
<xdf:Email />
<xdf:Codes> 327.23, 333.94 </xdf:Codes>
<xdf:Comment> This is a comment. </xdf:Comment>
<xdf:TestDescription> Tested for sleep disorders. </xdf:TestDescription>
<xdf:Medication> Ambien, Coumadin </xdf:TestDescription>
<xdf:Interpretation> Patient had abnormal sleep. </xdf:Interpretation>
<xdf:Recommendation> Patient needs CPAP. </xdf:Recommendation>
<xdf:FollowupPlans> Will followup with CPAP study. </xdf:FollowupPlans>
<xdf:PatientOpinion> Patient concerned about CPAP tolerance. </xdf:PatientOpinion>
<xdf:Physician />
<xdf:Technician>
<xdf:FirstName> Joe </xdf:FirstName>
<xdf:MiddleName> Bob </xdf:MiddleName>
<xdf:LastName> Technician </xdf:LastName>
<xdf:ID> 1515 </xdf:ID>
<xdf:WorkPhone> 1|352|555-0000|312 </xdf:WorkPhone>
<xdf:Pager />
<xdf:Fax />
<xdf:CellPhone />
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<xdf:Email> joebob@sleeplab.com </xdf:Email>
<xdf:Specialty />
<xdf:Titlel> RPSGT </xdf:Titlel>
<xdf:Title2 />
<xdf:Title3 />
</xdf:Technician>
<xdf:Referring />
<xdf:0rdering />
<xdf:Reading />
</xdf:PatientInformation>
<xdf :NoteLog>
<xdf:Note>
<xdf:Time> 2008-07-15T22:05:00.123-04:00 </xdf:Time>
<xdf:NoteText> Lights-out </xdf:NoteText>
</xdf:Note>
<xdf:Note>
<xdf:Time> 2008-07-15T22:15:00.639-04:00 </xdf:Time>
<xdf:NoteText> Lights-on </xdf:NoteText>
</xdf :Note>
</xdf :NoteLog>
<xdf:Video>
<xdf:VideoClips>
<xdf:VideoClip>
<xdf:Time> 2008-07-15T22:00:00.250-04:00 </xdf:Time>
<xdf:Duration> 20 </xdf:Duration>
<xdf:ClipFile> video/clipl.wmv </xdf:ClipFile>
<xdf:ClipComment> Seizure Event </xdf:ClipComment>
</xdf:VideoClip>
</xdf:VideoClips>
<xdf:NoteLog />
</xdf:Video>
<xdf:DataFiles>
<xdf:DataFile>
<xdf:File> EXAMPLE.RAWDATA </xdf:File>
<xdf:FrameLength> 1 </xdf:FrameLength>
<xdf:Endian> big </xdf:Endian>
<xdf:Sources>
<xdf:Source>
<xdf:Ignore> false </xdf:Ignore>
<xdf:SourceName> (3 </xdf:SourceName>
<xdf:SampleWidth> 2 </xdf:SampleWidth>
<xdf:Signed> true </xdf:Signed>
<xdf:SampleFrequency> 1000 </xdf:SampleFrequency>
<xdf:DigitalMax> 32767 </xdf:DigitalMax>
<xdf:DigitalMin> -32768 </xdf:DigitalMin>
<xdf:PhysicalMax> 3200 </xdf:PhysicalMax>
<xdf:PhysicalMin> -3200 </xdf:PhysicalMin>
<xdf:DigitalToVolts> 0.09765774 </xdf:DigitalToVolts>
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<xdf

:Unit> 0.000001 </xdf:Unit>

</xdf:Source>

<xdf:Source>

<xdf

<xdf:
<xdf:
<xdf:
<xdf:
<xdf:
<xdf:
<xdf:
<xdf:
<xdf:
<xdf:

:Ignore> false </xdf:Ignore>

SourceName> (4 </xdf:SourceName>
SampleWidth> 2 </xdf:SampleWidth>

Signed> true </xdf:Signed>

SampleFrequency> 1000 </xdf:SampleFrequency>
DigitalMax> 32767 </xdf:DigitalMax>
DigitalMin> -32768 </xdf:DigitalMin>
PhysicalMax> 3200 </xdf:PhysicalMax>
PhysicalMin> -3200 </xdf:PhysicalMin>
DigitalToVolts> 0.09765774 </xdf:DigitalToVolts>
Unit> 0.000001 </xdf:Unit>

</xdf:Source>

<xdf:Source>

<xdf:
<xdf:
<xdf:
<xdf:
<xdf:
<xdf:
<xdf:
<xdf:
<xdf:
<xdf:
<xdf:

Ignore> false </xdf:Ignore>

SourceName> Al </xdf:SourceName>
SampleWidth> 2 </xdf:SampleWidth>

Signed> true </xdf:Signed>

SampleFrequency> 1000 </xdf:SampleFrequency>
DigitalMax> 32767 </xdf:DigitalMax>
DigitalMin> -32768 </xdf:DigitalMin>
PhysicalMax> 3200 </xdf:PhysicalMax>
PhysicalMin> -3200 </xdf:PhysicalMin>
DigitalToVolts> 0.09765774 </xdf:DigitalToVolts>
Unit> 0.000001 </xdf:Unit>

</xdf:Source>

<xdf:Source>

<xdf

<xdf:
<xdf:
<xdf:
<xdf:
<xdf:
<xdf:
<xdf:
<xdf:
<xdf:
<xdf:

:Ignore> false </xdf:Ignore>

SourceName> Pressure </xdf:SourceName>
SampleWidth> 2 </xdf:SampleWidth>

Signed> true </xdf:Signed>

SampleFrequency> 1000 </xdf:SampleFrequency>
DigitalMax> 32767 </xdf:DigitalMax>
DigitalMin> -32768 </xdf:DigitalMin>
PhysicalMax> 3200 </xdf:PhysicalMax>
PhysicalMin> -3200 </xdf:PhysicalMin>
DigitalToVolts> 0.09765774 </xdf:DigitalToVolts>
Unit> 0.000001 </xdf:Unit>

</xdf:Source>

<xdf:Source>

<xdf

<xdf:
<xdf:
<xdf:
<xdf:
<xdf:

:Ignore> false </xdf:Ignore>

SourceName> Sa02 </xdf:SourceName>
SampleWidth> 7 </xdf:SampleWidth>
SampleFrequency> 1 </xdf:SampleFrequency>
DigitalMax> 100 </xdf:DigitalMax>

DigitalMin> 0 </xdf:DigitalMin>
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<xdf:PhysicalMax> 100 </xdf:PhysicalMax>
<xdf:PhysicalMin> 0 </xdf:PhysicalMin>
<xdf:DigitalToVolts> 0.01 </xdf:DigitalToVolts>
</xdf:Source>
</xdf:Sources>
<xdf:Sessions>
<xdf:Session>
<xdf:0ffset> 1000 </xdf:0ffset>
<xdf:Length> 9601200 </xdf:Length>
<xdf:StartTime> 2008-07-15T22:00:00.250-04:00 </xdf:StartTime>
<xdf:SyncMarkers>
<xdf:SyncMarker>
<xdf:Time> 2008-07-15T22:00:10.250-04:00 </xdf:Time>
<xdf:SyncDelta> 0.0012 </xdf:SyncDelta>
</xdf:SyncMarker>
</xdf:SyncMarkers>
</xdf:Session>
</xdf:Sessions>
<xdf:Montages>
<xdf :Montage>
<xdf:EffectiveTime> 2008-07-15T722:00:00.250-04:00 </xdf:EffectiveTime>
<xdf:Channels>
<xdf:Channel>
<xdf:Gl />
<xdf:G2> C3 </xdf:G2>
<xdf:Label> GND/C3 </xdf:Label>
<xdf:Sensitivity> 7 </xdf:Sensitivity>
<xdf:LF> 0.531 </xdf:LF>
<xdf:HF> 35 </xdf:HF>
<xdf:Type />
</xdf:Channel>
<xdf:Channel>
<xdf:G1> C4 </xdf:Gl>
<xdf:G2> Al </xdf:G2>
<xdf:Label> Al1/C4 </xdf:Label>
<xdf:Sensitivity> 7 </xdf:Sensitivity>
<xdf:LF> 0.531 </xdf:LF>
<xdf:HF> 35 </xdf:HF>
<xdf:Type> Central </xdf:Type>
</xdf:Channel>
<xdf:Channel>
<xdf:Gl />
<xdf:G2> Pressure </xdf:G2>
<xdf:Label> GND/Pressure </xdf:Label>
<xdf:Sensitivity> 7 </xdf:Sensitivity>
<xdf:LF> 0.159 </xdf:LF>
<xdf:HF> 15 </xdf:HF>

<xdf:Type> Pressure </xdf:Type>
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</xdf :Channel>

<xdf:Channel>

<xdf

<xdf:
<xdf:
<xdf:
<xdf:
<xdf:

:G2> Sa02 </xdf:G2>

LE />
HE />

</xdf :Channel>

</xdf:Channels>

</xdf:Montage>

</xdf :Montages>

<xdf:RevMontages />

</xdf:DataFile>

</xdf:DataFiles>

<xdf:ScoringResults>

<xdf:EpochInformation />

<xdf:Scorers>

<xdf:Scorer>

<xdf:ScorerID> 9BC7C81D-9D2D-4685-B08E-0B334F858299 </xdf:ScorerID>
<xdf:FirstName> Alice </xdf:FirstName>

<xdf:LastName> de Scorer </xdf:LastName>

<xdf:SleepStages>

<xdf:SleepStage>

<xdf:EpochNumber> 1 </xdf:EpochNumber>

<xdf:Stage> I </xdf:Stage>

</xdf:SleepStage>

<xdf:SleepStage>

<xdf :EpochNumber> 2

<xdf:Stage> 1 </xdf:Stage>

</xdf:SleepStage>

<xdf:SleepStage>

<xdf:EpochNumber> 3

<xdf:Stage> 1 </xdf:Stage>

</xdf:SleepStage>

<xdf:SleepStage>

<xdf :EpochNumber> 4

<xdf:Stage> R </xdf:Stage>

</xdf:SleepStage>

</xdf:SleepStages>

<xdf:Apneas>

<xdf:Apnea>

<xdf:Time> 2008-07-15T22:14:32.543-04:00 </xdf:Time>
<xdf:Duration>

<xdf:Class> Obstructive </xdf:Class>

</xdf :Apnea>

</xdf:Apneas>

<xdf:Hypopneas />

Label> Sa02 </xdf:Label>

Sensitivity> 10 </xdf:Sensitivity>

Type> Sa02 </xdf:Type>

</xdf :EpochNumber>

</xdf :EpochNumber>

</xdf :EpochNumber>

10.8 </xdf:Duration>
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<xdf:Desaturations />
<xdf:Microarousals>
<xdf:Microarousal>
<xdf:Time> 2008-07-15T22:12:14.873-04:00 </xdf:Time>
</xdf:Microarousal>
<xdf:Snores />
<xdf:LegMovementsl />
<xdf:LegMovements2 />
<xdf:FlowLimitations />
<xdf :NoteLog />
<custom:CustomSpikeEvents>
<custom:CustomSpikeEvent>
<xdf:Time> 2008-07-15T22:06:24.683124-04:00 </xdf:Time>
</custom:CustomSpikeEvent>
</custom:CustomSpikeEvents>
<custom:CustomRespiratoryEvents>
<custom:CustomRespiratoryEvent>
<xdf:Time> 2008-07-15T22:10:00-04:00 </xdf:Time>
<xdf:Duration> 15.2 </xdf:Duration>
<custom:LowestSa02> 82 </custom:LowestSa02>
</custom:CustomRespiratoryEvent>
</custom:CustomRespiratoryEvents>
</xdf:Scorer>
</xdf:Scorers>
</xdf:ScoringResults>
</xdf :0penXDF>

Figure 40 — Full OpenXDF Header Example
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